Messenger Shown with optional LCD module

User’s manual
Release Rev 1.002e

Be sure to read safety considerations section before using the equipment.
Store this manual in a readily accessible location for future reference.
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Contact your closest Monitek Representative for more information:

Galvanic Applied Sciences USA
101 Billerica Avenue Bldg 5, Ste104,
North Billerica, MA 01862 USA

Tel:  978- 848-2701
Fax: 978-848-2713

E-mail: support@galvanic.com
Web: www.galvanic.com
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http://www.galvanic.com/

Manufacturer’s Warranty Statement

Galvanic Applied Sciences Inc. (“Seller”) warrants that its products will be free from defects in materials and
workmanship under normal use and service in general process conditions for 12 months from the date of
Product start-up or 18 months from the date of shipping from Seller’s production facility, whichever comes first
(the “Warranty Period”). Products purchased by Seller from a third party for resale to Buyer ("Resale Products")
shall carry only the warranty extended by the original manufacturer. Buyer agrees that Seller has no liability for
Resale Products beyond making a reasonable commercial effort to arrange for procurement and shipping of
the Resale Products. Buyer must give Seller notice of any warranty claim prior to the end of the Warranty
Period. Seller shall not be responsible for any defects (including latent defects) which are reported to Seller
after the end of the Warranty Period.

THIS WARRANTY AND ITS REMEDIES ARE IN LIEU OF ALL OTHER WARRANTIES OR CONDITIONS
EXPRESSED OR IMPLIED, ORAL OR WRITTEN, EITHER IN FACT OR BY OPERATION OF LAW,
STATUTORY OR OTHERWISE, INCLUDING BUT NOT LIMITED TO, WARRANTIES OR CONDITIONS
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WHICH SELLER
SPECIFICALLY DISCLAIMS.

Seller’s obligation under this warranty shall not arise until Buyer notifies Seller of the defect. Seller’s sole
responsibility and Buyer’s sole and exclusive remedy under this warranty is, at Seller's option, to replace
or repair any defective component part of the product upon receipt of the Product at Seller's production
facility, transportation charges prepaid or accept the return of the defective Product and refund the purchase
price paid by Buyer for that Product. If requested by Buyer, Seller will use its best efforts to perform warranty
services at Buyer’s facility, as soon as reasonably practicable after notification by the Buyer of a possible
defect provided that Buyer agrees to pay for travel time, mileage from the Seller’s facility or travel costs to
the airport / train station closest to Buyer’s facility plus all other travel fees, hotel expenses and subsistence.

Except in the case of an authorized distributor or seller, authorized in writing by Seller to extend this
warranty to the distributor’s customers, the warranty herein applies only to the original purchaser from Seller
(“Buyer”) and may not be assigned, sold, or otherwise transferred to a third party. No warranty is made
with respect to used, reconstructed, refurbished, or previously owned Products, which will be so marked on
the sales order and will be sold “As Is”.

Limitations
These warranties do not cover:

+ Consumable items such as lamps.

* Analyzer components which may be damaged by exposure to contamination or fouling from the
process fluid due to a process upset, improper sample extraction techniques or improper sample
preparation, fluid pressures in excess of the analyzer's maximum rated pressure or fluid
temperatures in excess of the analyzer's maximum rated temperature. These include but are not
limited to sample filters, pressure regulators, transfer tubing, sample cells, optical components,
pumps, measuring electrodes, switching solenoids, pressure sensors or any other sample wetted
components.

+ Loss, damage, or defects resulting from transportation to Buyer’s facility, improper or inadequate
maintenance by Buyer, software or interfaces supplied by Buyer, operation outside the
environmental specifications for the instrument, use by unauthorized or untrained personnel or
improper site maintenance or preparation.

* Products that have been altered or repaired by individuals other than Seller personnel or its duly
authorized representatives, unless the alteration or repair has been performed by an authorized
factory trained service technician in accordance with written procedures supplied by Seller.
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* Products that have been subject to misuse, neglect, accident, or improper installation.

+ The sole and exclusive warranty applicable to software and firmware products provided by Seller
for use with a processor internal or external to the Product will be as follows: Seller warrants that
such software and firmware will conform to Seller's program manuals or other publicly available
documentation made available by Seller current at the time of shipment to Buyer when properly
installed on that processor, provided however that Seller does not warrant the operation of the
processor or software or firmware will be uninterrupted or error-free.

The warranty herein applies only to Products within the agreed country of original end destination. Products
transferred outside the country of original end destination, either by the Seller at the direction of the Buyer
or by Buyer’s actions subsequent to delivery, may be subject to additional charges prior to warranty repair
or replacement of such Products based on the actual location of such Products and Seller’s warranty and/or
service surcharges for such location(s).

Repaired Products
Repaired products are warranted for 90 days with the above exceptions.

Limitation of Remedy and Liability

IN NO EVENT SHALL SELLER BE LIABLE TO BUYER FOR ANY INDIRECT, CONSEQUENTIAL,
INCIDENTAL, SPECIAL OR PUNITIVE DAMAGES, OR FOR ANY LOSS OF USE OR PRODUCTION, OR
ANY LOSS OF DATA, PROFITS OR REVENUES, OR ANY CLAIMS RAISED BY CUSTOMERS OF
BUYER OR ANY ENVIRONMENTAL DAMAGE OR ANY FINES IMPOSED ON BUYER BY ANY
GOVERNMENTAL OR REGULATORY AUTHORITIES, WHETHER SUCH DAMAGES ARE DIRECT OR
INDIRECT, AND REGARDLESS OF THE FORM OF ACTION (WHETHER FOR BREACH OF CONTRACT
OR WARRANTY OR IN TORT OR STRICT LIABILITY) AND WHETHER ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES OR NOT.

Revision Date: June 2019
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1.1

General Information
Introduction

Monitek Messenger is a compact, highly efficient, and expandable system
that is designed to interface to a broad range of Monitek sensors. It also
has the capability to interface with multiple and different sensors at the
same time. It's modular design approach enables several applications to
be customized for a variety of measurements, such as Turbidity,
Suspended solids, Color and % Concentration using optical in-line
Sensors. The Messenger may be linked with Pocket PC’s with Windows
CE, Personal Computer or Laptop operating Windows 9x, NT or 2000 or a
Panel PC (also called a TPC with Windows CE or XP), the GUI (Graphical
User Interface) offers a completely menu-driven screens that are easy to
understand and also has online help. The GUI interface is designed to
allow three access levels (Operator, Technician and Factory) to prevent
an unskilled operator from changing any critical parameter in the setup of
the transmitter. The interface is intuitive with no need for programming
codes or program numbers. The system also includes some self-check
operations as well as the ability to access the basic measurement values
without the use of a multi-meter or even physically accessing the
electronics. The system includes the ability to perform field calibrations
while the instrument is installed in the process and is operating. It comes
factory pre-configured to your application. For most accurate setup we
recommend that the user calibrate on his process sample condition.

Please refer to Process calibration



Icons used in this User's Manual

& WARNINGS INDICATE SITUATIONS THAT COULD RESULT IN
THE INJURY TO HUMAN OPERATOR OR BYSTANDER. WARNINGS
ARE PRINTED IN ALL UPPERCASE CHARACTERS IN BOLDFACE
FONT

@ Cautions indicate situations that could damage the Monitek
Messenger or sensor. Cautions are printed in mixed case characters
in boldface font

Note Notes indicate miscellaneous information and are printed in mixed

case characters, in normal font

1.2 Safety Considerations
e Power source:

This instrument requires an input of 90-260VAC at 50-60 Hertz (unless otherwise
specified). A 24VDC/AC power supply is optional.

Installing AC Wiring:

AC power consumption is less than 50 Watts at 110 Volts AC. Use
#18AWG wire for power connections. Transmitter relay ratings for alarms
and external devices are 2 A at 250V~ maximum; use #18 AWG or
20AWG for wiring.

& WARNING: MAKE SURE THE AC POWER MAINS ARE
SWITCHED OFF OR OTHERWISE DISCONNECTED BEFORE YOU
BEGIN WIRING THE SYSTEM TO AVOID THE POSSIBILITY OF
ELECTRICAL SHOCK. IT IS A GOOD PRACTICE TO INSTALL A MAIN
POWER CUTOFF SWITCH NEAR THE SYSTEM WITH EXTERNAL
MAIN FUSES.

e Proper instrument grounding:

The instrument must be grounded to avoid electrical shock hazards
to personnel, damage to the unit and erroneous operation.



1.3

1.3.1

& THE SYSTEM REQUIRES AN AC-GROUND (EARTH
GROUND) AND ALL SENSORS CONNECTED TO THE
TRANSMITTER MUST BE GROUNDED.

e Do not operate with open enclosure. Exposed electronics will promote
the risk of electrical shock and might cause damage to the unit.

e Do not alter cable length. The instrument was calibrated with a
specified cable length. Altering cable length can cause unstable
signals and void instrument calibration.

o Keep original packing materials. Ship the instrument in the original
packing material to avoid damage to the sensor or transmitter. If
packing material is needed, contact Monitek.

e Mishandling of the sensor is not covered under warranty. Do not
disconnect the interior wiring of the sensor.

Device Installation
Transmitter Location, specifications and installation.

The transmitter should be installed using the mounting ears in a
vertical position. The transmitter should not be installed in direct
sunlight, as this will tend to cause abnormally high heat inside the
enclosure, also avoid locations that are close to excessive heat

generating equipment.



Specifications:

Sensors:

Includes MoniTurb-F, MoniTurb-FS, MoniSpec AD, Cell
Density Probes FS4&FS5, 210, MoniSpec A, MoniTurb-S,
TS2, Model 22 Probes, Model 25 Probes (includes CSK,
CSH, CSS), Model 450 (CS6, CS8) with external power

supply.

Number of Sensors: 1 to 4 sensors. Each sensor may be linked to a separate 8

points Calibration table with 1% order or Curve fit linerization
techniques.

Area Classification: General Purpose

Environmental:
Operating Temp:
Humidity:

User Interface:
Alarms:

Display:
Programming:
Analog Outputs:

Internal Relays:
Digital Inputs:

Digital Output:

Power
Input Power:

-14 °F to 122 °F (-10 °C to 50 °C)
0 to 95% RH, non condensing

Low High Alarms and General Fault Alarm are user
programmable, latching or non-latching, energized or de-
energized with programmable alarm delay and hystersis.
Optional, 4 lines by 20 Characters backlight LCD.

Using Desktop, Laptop or touch screen PDA or Panel PC.
Two standard 0/4-20 mA Isolated. Optional Two additional
outputs 0 to 1000 Ohms

Optional, 4 relays fully programmable rated at 2A/250VAC
Four Digital Inputs, fully programmable with activate levels of
51024 VDC

RS-232 or RS-485 using Modbus RTU protocol.

90 to 260 VAC 50/60 Hz Optional 24V

Power consumption: less than 50 watts

Construction
Dimensions:

Weight:
Case Material:

Approvals
Warranty

7.1in. (180mm) H x 6.3 in. (160 mm) W x 3.6 in. (90,5mm) D
or [4.5 in. (115mm) D with LCD Display].

approx. 7 lbs (3.2 Kg.)

304 Stainless Steel

CE
One year (materials and workmanship)



OPTIONAL LCD DISPLAY
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The product is pre-configured at the Factory for the dedicated sensor hardware.
So in most cases, you may not need to change the jumpers on the Main board. If
you really need to change the settings, please write down the original setting

before changing any settings.

1.3.3 Sensor wiring and connections:

The table below shows a typical Forward Side scatter sensor connections to a
Messenger.

MONITURB FS (Forward and Side Scatter) Flow cell.

Terminal | Wire color | Cable ID Signal

1 Brown FS module (-) Direct beam

2 White FS module (+) Direct Beam

3 Black FS module (AC-GND) Shield
4 Yellow FS module (-) 12 Deg. Sensor
5 Green FS module (+) 12 Deg. Sensor
6 -

7 Yellow SS module (-) 90 Deg. Sensor
8 Green SS module (+) 90 Deg. Sensor
9 Black SS module (AC-GND) Shield

Lamp connections

Terminal
1 Lamp (Blue and Red)
2 Lamp (Grey and Pink)
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1.4

1.4

Software Installation

.1 PC Version

System Requirements

Supported Operating Systems

Window 95, 98,NT, 2000, ME, XP

RAM

32MB

Hard Disk Space

SMB

Installation procedure

Close any open programs that are running on your computer before starting

the installation.
Double click on setup.exe.

As the installation progresses, follow the instructions on the screen. Some

Windows system files will be updated to newer versions during installation

of Messenger software. If these updates are done, you will be required to

reboot your PC. If so, repeat steps 1 through 2 of the installation procedure

to continue with the installation. Once the installation of Messenger software

is complete, you will be required to restart your computer once again for

proper functioning of the software.

Welcome screen shown below will appear, Click OK to continue the

installation process. To abort the installation process click Exit Setup.

1 Monitek Messenger Setup

be running.

% ‘Welcome to the Monitek Messenger installation program,
g

Setup cannot install system files or update shared files if they are in use,
Before proceeding, we recommend that vou clase any applications yau may

(a4 Exit Setup

-14-




V. Choose the Destination location.

1 Monitek Messenger Setup x|

Begin the installation by clicking the button below.

Click. this buttan ta install Manitek Messenger software ko the specified
destination directory.

Directary:
’VC:'I,Pngram Files\Messenger Graph, _hange Direckory

Exit Sekup

VI. To change the default destination location click on Change Directory.

Choose new destination location using the following screen.

.E Change Directory . EI

Enter ar select a destination direckary.

Directories:

ety oK

£4Program Files

& Messenger Graph

Cancel

Drives:

Igc: j

VII. Choose the program group under which the application has to appear.

-15-



¥ Monitek Messenger - Choose Program |

Setup will add items ko the group shown in the Program Group bo,
You can enter a new group name or select one From the Existing

Groups lisk,

Progran Group:

Wonikek Messenger

Exisking Groups:

ACcessories
Exndus

HTML Help ‘Workshop

Presvious Daka Test Ltility
Skartup

| Continue I

VIIl. Click Continue.

IX. Dialog showing the status of the files being copied will be displayed.

X. On Completion of Installation Process Message “Installation process

complete” will appear.

XlI. Click on OK to finish the installation process.

1.4.2 Pocket PC Version (PDA)

System Requirements

Supported Operating System

Windows CE 3.0

Supported Process Types

ARM, MIPS, SH3

Storage Space on Pocket PC

4MB

Installation Procedure

I. Place the Pocket PC in cradle.
Il. Connect the Mobile Device (Pocket PC) via Active Sync to the Desktop

Computer.

-16-




[ll. Double click on setup.exe.
IV. Dialog appears as shown below.

Setup will ingtall pour application in the fallawing
Destination Faolder.

'ou may change the Destination Folder if you wigh.

Then click OF. ta inztall.

C:\Program Fileshheszenger » |
0K | EsitSetp |

|' Dreztination Folder

V. Accept the Default Installation Folder(C:\Program Files\Messenger\). Click
OK to continue the Installation Process or Click Exit Setup to abort
Installation.

VI. Message is prompted whether application needs to be installed in default
Application directory as shown below.

Installing Applications

VII. Choose Yes to Install the Application in Default directory, No to install the
application on FLASH CARD.
VIIl. On Completion of downloading the Application to Pocket PC, Message is

displayed as Shown below.

-17-



Application Downloading Complete ﬂ

Please check vour mobile device screen ko see if additional steps are necessary to complete this

installakion.
(] 4 |

IX. Follow the instructions on the Pocket PC to complete the installation

process

-18-



1.5 Menu layout and Operation
1.5.1 Messenger Software Navigation Tree (Operator)

| Start/Exit Menu |
v v N4
| Select Language | | Main Menu | | Select Messenger
v
v Vv Vv v Vv
Setup Inputs/ Diagnostic Set Cleaning Set Access Measurement
Outputs Menu Event Level Screen
Set Alarms | Clear/Reset Menu |
Previous
| Reset Alarms | Data
Online
Software Revision Data
> Graph
Settings
Copy Image
S Copy Data
> Save As Bmp
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1.5.2 Messenger Software Navigation Tree (Technician)

| Start/Exit Menu |
[
v 12 v
| Select Language | | Main Menu | | Select Messenger
\2 Vv v v v v v v
Calibration Setup Results Setup Inputs/ Diagnostic Set Cleaning Set Access Set Access Measurement
Menu Menu Outputs Menu Event Code Level Screen
. I
— Factory - —l
Calibration Setup Results N Set LCD — File Menu Previous
Nametags Display Data
View/Edit Load Parameters from file
— i i Setup Numerical i
Calibration Results —> S%tu’?gsgg Save Parameters to file O;a“tnae
. Save Previous Data to file
Graph Setup Graphical LS| Assign Digital Setup
Results Inputs Load Firmware Graph
Process SetUR&_etsuIts sl SetCOM Port —>| View Channel Output | Graph
—> ibrati nits Settings
—— 1 Calibration | Adjust Hardware Settings |
Setup Data >|  SetAlarms Copy Image
Build Logging r —> Zero Dark Current Py 9
Calibration 7 e
—> Optimize Channel Auto
Set Messenger Copy Data
Set Buffer Unit Id
View/Edit Size ni —>| Optimize Channel Manual
Calibration
—> Set Relay >| Set Dark Current Auto Zero Save As Bmp
Bubble Reject Functions
Graph Threshold —> Set Channel Reference
—>
Setup Results _>| Calibrate Analog Outputs
Format
N Fit Data > | Set ADC Gain Manual
Set Results
Offset —>[ Hardware Test
Copy
Factory Table Lamp Control
—>| Test Analog
—>| Test Relays
> Clear/Reset Menu
System Reset
Default values
Clear Process Calibration
Clear Results
Reset Alarms
L> | Software Revision

220-



1.5.4 Messenger Software Navigation Tree (Factory Level)

| Start/Exit Menu
I
\2 v v
Select Language | | Main Menu | | Select Messenger
v 3 v 2 32 2 32 v
Calibration Setup Results Setup Inputs/ Diagnostic Set Cleaning Set Access Set Access Measurement
Menu Menu Outputs Menu Event Code Level Screen
I I |
—> Factory ) —
Ealibeatign: Setup Results —> Set LCD — File Menu Previous
Equations Nametags Display Data
Biitet Load Parameters from file
CalibgpLion Setup Results Set Analo onli
> g ) nline
Equations Outputs Save Parameters to file Data
Aoy i . Save Previous Data to file
Calibration Setup Sensor L5 Assign Digital Setup
Equations Inputs Load Firmware Graph
Setup Numerical L 5| Set COM Port _>| View Channel Output | Graph
Results Settings
| Adjust Hardware Settings |
Setup Graphical | SetAlarms Copy Image
Fl)iesulpt)s — > Zero Dark Current 44 9
— Optimize Channel Auto
PrOCGS.S Set Results Set Messenger P Copy Data
| Calibration Units Unit 1d
ni —>| Optimize Channel Manual
Build Setup Data —> Set Relay >| Set Dark Current Auto Zero Save As Bmp
“| calibration Logging Functions >
% —> Set Channel Reference
View/Edit Set Buffer —>| Calibrate Analog Outputs |
Calibration Size
> | Set ADC Gain Manual |
Ecfitsaksr Bubble Reject N filaBrecreden
" Equations Threshold
SystempResatrol
Setu%ﬁfé\ﬁor Setup Results
>| Equation: Format 3 Defwgtm
Copy Set Results Clear ProrgssiGakipeation
>| Factory Table Offset
LS Clear Factory Calibration
—> Clear Results
Reset Alarms
—>
—
—
—_—>
e
—>| Software Revision

21-



1.6

RS-232 cable Supplied for

Interconnections to PC/PDA

PC connection -

9 PINS FEMALE

Messenger Pin Color RS-232 (9 Pins Female
connector)

16 (DSR) RED wire 4 (DTR)

17 (TX) White wire 2 (RX)

18 (RX) Black wire 3 (TX)

19 GND Green wire 5 (GND)

RS-232 cable Supplied for Pocket PC connection - 9 PINS MALE

Messenger Pin Color RS-232 (9 Pins Male

connector)

16 (DSR) RED wire 4 (DTR)

17 (TX) White wire 3 (RX)

18 (RX) Black wire 2 (TX)

19 GND Green wire 5 (GND)

22




2. Setup and calibration
Help
¥IEVY CALIBRATION RESULTS

for Sensor 1

Sample #
1

2
3
4
5
5]
K
a

The system is calibrated at the factory using clean laboratory standards. For best
results we recommend that the user calibrate using the process conditions. The
system has TWO types of calibration that can reference sample measurements:
Factory and Process Calibration. The factory calibration is to be used as
reference. Calibration may be done in the field using sample conditions; the user
may alter the data acquired by the system in the View/Edit calibration screen. Up
to 8 data points may be entered and the user may select either a Linear fit or a
curve fit equation. For a range where the upper and lower limits are known the
curve fit gives the best fit, if the range is extended, select the Linear fit for best

approximation.
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21 Field Calibration and Curve Fitting
Help

BUILD PROCESS .
CALIBRATION TABLE

Sample #

OLD
User Yalue - “
pata [N

Read Mew Data
STORE Mew Yalue

MONITEK MESSENGER includes a feature that allows the user to calibrate the
instrument in-line. Once the instrument is installed and operating, data points
can be taken and stored using the View/Edit Data selection from the Calibration
menu. First select a sample point from 1 to 8 then the user can select “Read
New Data”, and the MONITEK MESSENGER will read the current value and
store it. At the same time that the user saves that sample into the MONITEK
MESSENGER, a manual sample should be taken from the process. This sample
should be analyzed for the appropriate content in the laboratory. Once the
laboratory has established the value, the user can come back to the “View/Edit
Calibration” Data screen and select the appropriate sample point. The user
should then enter the laboratory value for that data point. The MONITEK
MESSENGER has now stored the proper laboratory value to the actual Data
value that the instrument was reading when the sample was taken. This should
be repeated for several values at different ranges of the expected operational
span of the process.
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¥IEW CALIERATION RESULTS
FIT SENSOR 1

. for Sensor 1
Using

LIMEAR FIT PROCESS DATA

SETUP SENSOR. EQUATION
BACK

. 057678 1,15157 172730 2,20214
linear ft curee R

Edit Sensor Equations
TAEBLE
BALCK

Once at least three values have been stored, the system can perform a curve fit.
Select Curve Fit from the Calibration menu and the MONITEK MESSENGER wiill
fit a Linear fit or a curve fit through the data points that are entered into the
sample data table. The MONITEK MESSENGER will then display the curve, and
that calibration curve will become the active curve for the instrument. The
MONITEK MESSENGER can be calibrated and programmed to read the same
value on the front panel as the concentration value that was determined by the
laboratory. This unique method is the ideal way to calibrate an in-line device
because it takes into account the real dynamics of the process and allows the

device to read out in the same units that the user will receive from the laboratory.

To Access Process Calibration you need to enter “Technician Access” level and
to Access Factory Calibration data you need to enter Factory access level. The

following procedure explains in step how a Process Calibration may be done:
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» Set the Access Level to Technician and then select Calibration menu.

. MESSEMGER

Help

SET ACCESS LEYEL SETUP CALIERATION MENU

Current access level is: m

S -
Setup Factory Ii
Calibration
New Access Code m

Setup Process
Calibration

PATN MENLT

» Select “ Setup Process Calibration” and Then “Build Calibration”

» Up to FOUR sensors may be configured in the Messenger. Typically
Sensor #1 corresponds to Result # 1 and Sensor # 2 corresponds to
Result # 2 and similar setup for 3 and 4.

» At least three data calibration points are needed to get a good
representation of the data curve. If you are only doing Turbidity then all
you need is to calibrate sensor #1. Enter the value for the sample in the
cell and then press “Read New Data”, you may want to repeat pressing
“‘Read New data” until you feel that the number is fairly the same between

successive reads. Press “Store New Value” to store selected values.
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BUILD PROCESS .
CALIBRATION TABLE

Sample #

OLD
User Yalue - “
ata [N

Read Mew Data
STORE Mew Yalue

You may proceed to enter the various calibration data points by selecting
Sample # (1...8) and entering the corresponding values.

When done go “BACK” to previous menu and select “View/Edit
Calibration”.

In View Calibration Results the user may review or edit the calibration data
and then view graph to review the shape of the calibration curve as shown
below.

The system will show the Linear fit and curve fit curves. User may select
which curve fit represents his process better.
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Help Help

Sample #
1— : E362 T

4026 T

2884 T

s Il Il Il [l

o F 0.34612 069220 1,02838 13945
linear fit curee AE

Edit Sensor Equations Edit Sensor Equations

GRAPH

» Using “Fit Data” menu you may select either to use the Factory or Process
calibration for sample analysis. You may select “Factory Calibration” data
as reference but in most cases the process calibration will be more

accurate as it represents the sample and not the factory standards.

Help
FIT SENSOR. 1

Using

CURYE FIT PROCESS DATA

SETUR SENSOR EQUATION
BACK

> You may repeat the above procedure for the various sensors that are

connected to the system.
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2.2 Analog Outputs and Alarms

The system includes TWO analog outputs that may be set as 0-20 mA or 4-20
mA or 20-0 and 20-4 mA (Reverse acting). Two additional analog outputs may be
added as an option. Also OPTIONAL the user may add “Relay and Digital Inputs
card” with four SPDT relays for process alarms or controls, the same board
includes 4 digital inputs for additional control by external devices like a PLC
(Programmable Logic Controller) or other equipment. The Analog Outputs (4-20
mA) have been calibrated at the factory and may be trimmed or re-adjusted by
the user under the “Adjust Hardware settings” screen menu. These analog
outputs values are a direct function of whatever values are on the display. The

4-20mA outputs operate over a wide range, a minimum of 25 to 1000 Ohm load.

The alarm contacts are also controlled by the display value. The alarm values

are selected and Setup in the “Setup Inputs/Outputs” menu.

BUBBLE REJECT THRESHOLD .
Max. allowed change per
second {0 = off})

Bubble  Filter Delay
Reject

Channel 1 _'E:-:‘:. _E:E!E

Channel 2 _'E:-:';. _E:E!E
Channel 3 _EIIIII%E EIIIIISEE
Channel 4 _'E:-:‘:. _E:E!E

Set Default Yalues

The Monitek Messenger also includes a feature that allows the customer to
dampen the response of the system, by including added signal filtration. A unique
bubble reject feature is also available; this feature allows the system to reject

spurious signals caused by bubbles presence. The factory default is set for 5%
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and Filter response to 5 sec. The Bubble Reject feature control may be
accessed from the Setup Results menu.

2.3 Display Units

To display the process variable or sample Analysis the user should select
MEASUREMENT SCREEN.

The display units are the units of measure that the user wants to appear on the
display. This bears no relation to the calibration values, it is simply a tag
displayed below the sample process result variable. This is selected from Setup
Results = Set Results Units.

SET RESULTS UNITS

Result 1
Result 2

Result 3

Result 4  FYIRyage

Up to NINE characters may be entered.
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2.4 Data Trending Display and RS-232 Output.

The system includes memory storage of process results data. This data is stored
and will NOT be lost if power is disconnected from the transmitter. This feature is
meant to allow operations personnel to check on recent changes or trends in the
process by displaying the trends directly on the display of the linked device (PC,
PDA or TPC) logging again.

SETUP DATA STORAGE SIZE .
Total max. stored Results = 8000

SETUP DATA LOGGING

Store Result 1 every

m Seconds

Result 1 Storage Size

ETER Valves

Result 2 Storage Size

Store Result 2 every

m Seconds
m Yalues

Store Result 3 every

m Seconds

Store Result 4 every
m Seconds

Set default values

Result 3 Storage Size

ETER Valves

Result 4 Storage Size

ETER Valves

Set default yvalues

Set Data Storage Size

The Maximum number of data pints stored is 8000. The user may allocate all the
8000 points to one sensor (Result) or may divide them as needed.
Based on the default setup of one data point every 60 seconds and 500 points

per result, the Messenger will continuously have the last 8 hours of sample data.

Selecting Measurement Screen and then selecting Graph Data for displaying
results display the data trend. The Graph settings (Setup Graphical Results)
may be accessed under “Setup Results menu” where maximum and minimum
values for the y-axis (the process variable) as well as the time interval for data
collection and display. The system will then display whatever data is in storage
and the time span on the x-axis will be whatever the selected logging span

duration. Plotting the data does not erase or corrupt the data, so the user can
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actually re-plot the data and zoom in or out on the y-axis by entering different

values.

2.5 Self-Cleaning Interval

The interval between automatic self-cleaning cycles is selected from the “Set
Cleaning Event” option on the System menu. The value is entered in minutes.
The MONITEK MESSENGER holds the display and all outputs at the previous
value while the self-cleaning cycle is underway. Once the self-cleaning cycle is
complete, the instrument returns to normal operation. The self-cleaning cycle
can always be initiated or tested by selecting the “Start Clean Cycle” option from
the Set Cleaning Event Menu.

SET CLEANIMNG EVEMT
Clean Event 1

|_Clean Event 1 _ | Clean Event2

SET CLEAMIMG EYENT
Clean Event 1

|_Clean Event 1 | Clean Event 2

Cleaning Frequency “

in Hours 0-999.9

Cycle Duration in “

Cleaning Frequency “

in Hours O - 9999

Cycle Duration in “

Minutes 0.01 - 999.9

Purge Time in “

Minutes 0.01 - 999.9
Selected

Device Relay 1

b L CLEANING. CYCLE

Minutes 0.01 - 999.9

Purge Time in “

Minutes 0.01 - 999.9
Selected

pevice  [ECLENN

et LR CLEANING. CYCLE

When manually starting a cleaning cycle make sure you have the variables set
properly and a device selected.

Note: The Monitek Messenger Provides the electronic control for the signals
needed to activate cleaning jets. The user must provide the appropriate
hardware, including sensor with cleaning jets, a solenoid valve to switch either
pressurized air or cleaning solution (water for example) to the cleaning jets in the

flow cell.
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2.6 LCD Display (OPTIONAL) Contrast Adjust

The LCD display contrast adjustment is controlled by the contrast adjustment in
the “Setup LCD Display” menu, which can be accessed by selecting “Setup
Inputs/Outputs” in the Main menu. This may require some adjustment upon
initial start-up due to climate changes. There may also be occasional need to
re-adjust the contrast due to seasonal changes, especially if the MONITEK
MESSENGER is located outdoors. To change the LCD contrast use the “+” or “-*
keys to increase or decrease contrast setting.

Help

SETUP LCD DISPLAY OF .
RESULTS

(N3 T=0 R Turb.F. EBC
Resulkl 2 Decs

Line 2 |MCHas

Result2 2 Decs
Line3 (WS E

Result3 2 Decs

(W= S Monitek Messenger

MNone 3 Decs

Please Note that the LCD display messages are set by the user. When a Result
is selected for one of the FOUR lines the text is limited to 9 characters.

When a result is selected the user may also set the number of decimal points to
be displayed for the result. If “None” is selected, in the left option box under each
line text, then the system will display the message listed in the line up to 20

characters.
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3 System and Troubleshooting

3.1 View Channel Output Display

¥IEW CHANNEL OUTPUT .

Channel 1 T mv
Channel 2 [RENIN mv
Channel 3 [IEIIE mv
Channel 4 [IEYIIE mv

Msgr Amb Temp 23l DegcC

Turn Lamp OFF

External Lamp OFF
Show Raw Data

The MONITEK MESSENGER includes a feature that allows the user to display
the primary measurement values (in mV) of the system directly on the screen.
The “View Channel Output” option in the “Diagnostics menu” will display the
Channels signals i.e. the direct beam value, scatter beam or other signal
connected. The scatter beam and direct beam values are the amount of light
being received by each of the direct and scatter beam detectors respectively.
Forward scatter turbidity is defined as the ratio of the amount of light scattered at
12° to incident divided by the amount of light making it directly across the optical
gap. As more suspended solids or oil droplets are present, more light is
scattered and less is transmitted, making the ratio of these two become larger.
The ratio value is determined by dividing the scattered beam by the direct beam.
This is the same value that is recorded in the Sampled column of the View/Edit

calibration Data screen.
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3.2 Factory Calibration

PROCESS CALIBRATION
Sensor 1

Build Calibration
¥iew/ Edit Calibration
Fit Data

Copy factory table

MAIN MENU
BACK

The user may elect to switch to factory calibration if his measurement data using
the process calibration are not correlating. The factory calibration data may be
copied into the “Process Calibration” menu by selecting “Copy factory table”. A
data fit, on this transferred factory data may now be performed by selecting “Fit
Data”, the unit will use the factory calibration data to report the cell sample
analysis. At the factory, Formazin standards were used to create the calibration
data table. The Sensor is calibrated with at least 3 data points: a nominal 0 FTU
standard, a full-scale standard and a mid point standard. This feature is included
to allow easier troubleshooting by referencing known and factory verified
calibration. Alternatively the Field process calibrations may be checked against
the Formazin or diatomaceous calibration data performed at the factory.
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3.3 Toggling Between Factory and User Calibration

Help
FIT SENSOR. 1

Using

LIMNEAR FIT FACTORY DATA

SETUP SENMSOR. EQUATION
BACK

The user can activate the field calibration or the factory calibration. Selecting “Fit
Data” menu allows the user to select which calibration the system uses to
Display results. This is intended to give the user the ability to switch between
Factory and Process Calibration as a method of checking the existing primary

calibration or performing a new primary calibration.
3.4 Default parameters:

Take extreme care when you are trying to DEFAULT all the parameters.

@ This Option will DEFAULT ALL Parameters.

Consult factory before proceeding with this menu, as the system will require you
to either re-enter manually all the parameters or load back the setup file to go
back on line. Make sure that you have saved the setup before proceeding with

“‘Default values” option.
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CLEAR [ RESET MENU

SYSTEM RESET

Gefault ¥alues

Clear Process Calibration

Elear Fackory Calibration

Clear Results

Reset Alarms Default ¥alues E |

DIAG MEMU
Areou Sure?

DO NOT PROCEED UNLESS YOU HAVE SAVED YOUR SETUP IN
FILE MENU.

3.5 Access Levels and Codes
The system has three Access levels:
Operator: Default Access code 123

Technician: Default Access code 1234
Factory: Reserved for Factory Access.
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3.6  Error and Warning Messages

Error/Warning Messages Description

Restart the program to change

language.

For New Language settings to take effect

Restart the Messenger Application

CAUTION! Download-Program
required. Messenger will be

stopped. Continue anyway?

"Flip" Program is required to load the
Firmware. Messenger Device should be

stopped to load the Firmware

Save these values?

Existing Parameters have changed. Do

you want to save the NEW Parameters

Normalize to 0

Normalize means to set in relation to a
selected channel. If this channel is "0", it

would result in a "Divide by Zero"!

Warning: All Data in the Messenger
will be defaulted to factory settings,

Are you sure?

ALL the existing PARAMETERS &
PREVIOUS DATA will be lost and
Messenger will be defaulted to factory
settings

Value out of range

Entered value exceeds the specified
range of the parameter

Invalid File Format

Selected file (*.pda) is corrupt

Saving these values will cause in

Loss of "Previous Data"

Changing the existing parameters will

clear "Previous Data"

Invalid File Extension

Selected file doesn't have .pda extension

No Data Available

Currently there is no "Previous Data"

stored

No More Data Points

There are no more data points in the

current DATA frame to Navigate

Are you sure you want to clear

stored Results

"PREVIOUS DATA" of Selected Result

will be cleared
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Are you sure you want to clear all

stored Results

"PREVIOUS DATA" of ALL Results will

be cleared

Port not available

The Selected Comport (RS-232 / RS-485)

is used by another Application

Overflow! Reduce gain?

If you try to auto-set the gain, the signal
has to be in range. If gain is already high,
it has to be reduced to fit signal to range.

Fill blank fields!

Entered data contain NULL values

Please go online

Connect to Messenger Device

Entered code is not correct.

Entered Access Code doesn't match

Unit ID must be an integer between
0 and 255.

Entered Unit ID value is out of range

Invalid Data

Entered Data is Not Valid Ex: - characters

entered instead of Numeric value

Are you sure you want to exit this

program?

Exits the Application

NO RESPONSE: Please check
device ID# or run the search

function

Currently no Device exists in the Network
with the specified ID. Navigate to Select
Messenger and Run the Search Function
which gives the List of Devices present in
the Network

Changing language requires
closing of the program. Are you

sure?

Switching to a different Language

requires restarting the Application.

All data in the Messenger will be
overwritten with data from this

device. Are you sure?

Loading the parameters from .pda file will
cause ALL the current parameters to be

Overwritten.

Access codes cannot be modified
in OFFLINE mode

To modify the Access codes switch to
ONLINE mode.
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You are OFFLINE. Please load file
first

To Edit the parameters in OFFLINE
mode you need to First load the .pda
File.

NO RESPONSE

Communication between GUI and
Messenger Device has failed. Verify

the connections.

Lower Limit cannot exceed upper

Limit

Entered parameter Lower Limit value

exceeds the upper limit value.

Optics Fault

Optical Fault has occurred

Lamps Fault

Lamp Fault has occurred

Fault: -- mA

Fault is registered at Analog output.

Where -- Represents the fault current.

List of Codes displayed in STATUS BAR of MEASURMENTS SCREEN

are shown below.

1 Alarm 1 Active

2 Alarm 2 Active

3 Alarm 3 Active

4 Alarm 4 Active

CccC1 Cleaning Event1 Active
CC2 Cleaning Event2 Active
For Example: -

Code in STATUS BAR “1,3,CC1” indicates that Alarm1, Alarm2 and Cleaning

Event1 are currently Active

List of Messages displayed on LCD Display.

OpticFIt

Optical Fault has occurred

LampsFIt

Lamp Fault has occurred

Data Transfer...

Data Transfer between Messenger and
GUI in Progress
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4 Software Upgrading
41 Firmware
I. Run the Messenger Application Installed in PC or Pocket PC.
II. Navigate to Main Menu > Set Access Level, Enter Technician/Factory

Access level password.

[ll. Navigate to Main Menu > Diagnostic Menu > File Menu.

Help
FILE MANAGEMENT

Load parameters from a File

Save parameters to a File

Save Previous Data ko File

Load Firmware
BACK

IV. Choose Load Firmware.
V. Caution Message appears as shown below.

Messenger

VI. Choose Yes.

VII. Run the FLIP (Flexible-In System Programmer) Application.
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VIIl. Choose Start > Programs > Atmel Wireless & uC > Flip. Dialog appears
as shown below.

Atmel Wireless & Microcontrollers - Flip 1.4.9 o ] oS
File Buffer | Device 3ettings Help
Buifer Informatian Mo device selected |
gI[aS:E:h " Size: Ed f btz
ﬁa"d o Blank:  FF
gad...
F - Range 0000 - FFFF
Program
ey Checksunm:
- Offzet: 0000
I™ Blank Check Mo Reset Before Loading
HEX File:  none
¥ Frogiam
I “erify
[T SetSpecial Eytes
Fun Clear |
|Device » Select... | |E0mm. OFF

IX. Navigate to Device > Select. Dialog Appears as shown below.

=101 x|

Device: TRACHIRDZ2 — |

k. Cancel |

X. Choose the Device as T8951RD2

XI. Navigate to Settings > Communication > RS-232 Menu. Dialog appears as

shown below.
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XIl.

X1

XIV.

XV.

XVI.

XVII.

XVIII.

4.2

=101 i

Part: COk1 =

B aud: a7YE00 —

I:u:unneu:tl Discu:unneu:tl S_I,Inu:hru:ul Cancel

Choose the communication port and baud rate to communicate with

Messenger Device. Default Baud Rate of Messenger Device is 57600.

Click Connect.

Navigate to File > Load Hex File. File Open Dialog appears.

Choose the File to be loaded.

Choose RUN on the bottom left corner of the screen to initiate firmware

upgrade.

“‘Memory Verify pass” message will be displayed on the status bar on
completion of upgrade.

Recycle the power of the Messenger Device.

PC Version

Close any open programs that are running on your computer before
upgrading.

. Double click on setup.exe.

Welcome screen shown below will appear, Click OK to continue the

installation process. To abort the installation process click Exit Setup.
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¢ Monitek Messenger Setup

Beqin the inskallation by clicking the buktan belaw,

Click this buktan ta inskall Manitek Messenger saoftware to the specified
destination directary,

Directaory:
’VC:'l,F'rcugram FilesiMassenger Grapht, Chamge Directory

Exit Setup

IV. Choose the Destination location.

V. To change the default destination location click on Change Directory.

VI.

Choose new destination location using the following screen.

l?, Change Directory il

Enter or select a destination direckory.

Path:

£ \Program FilesiMessenger Graph

Direcktaries:

'al::ll, oK

£3Program Files

& Messenger Graph

Cancel

Drives:

Igc: j

Choose the program group under which the application has to appear.
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#J Monitek Messenger - Choose Program Gr x|
Setup will add items ta the group shown in the Program Group bos,

¥ou can enter a new group name of select one From the Existing
Groups list,

Program Group:

Monikek Messenger

Existing Groups:

Accessaries
Exodus
HTML Help “Waorkshop

Monitek Messenger
Previous Data Test Utiliby
Skartup

Conkinue I Cancel

VIl. Click Continue.

VIII. Dialog appears indicating Application files already exist.

Yersion Conflick x|

& file being copied is older than the file currently on wour syskem, It
is recommended that wou keep wour existing File.

File name:  ‘"CiiProgram Files\Messenger GraphlMsngr, pda’

Description: "
Your version: "

Do wou wank to keep this file?

Mo Mo ko Al

IX. Click “No to All".
X. Dialog showing the status of the files being copied will be displayed.

XI. On Completion of Installation Process Message “Installation process

complete” will appear.
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XIl. Click on OK to complete the installation process.

4.3 Pocket PC Version (PDA)
|. Place the Pocket PC in cradle.

Il. Connect the Mobile Device (Pocket PC) via Active Sync to the Desktop

Computer.

[ll. Double click on setup.exe.

IV. Dialog appears as shown below.

Setup will inztall paur applicatian in the fallawing
Destination Faolder.

'ou may change the Destination Folder if you wigh.

Then chick OF. ta insztall.

C:%Program Files'heszenger - |
ok | EstSewp |

|' Destination Folder

V. Accept the Default Installation Folder(C:\Program Files\Messengen\). Click
OK to continue the Installation Process or Click Exit Setup to abort

Installation.

VI. Message is prompted indicating that Application has already been

installed.
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VII.

VIII.

IX.

X.

XL

Applications Already Installed

Choose YES to upgrade or re-Install the software

Message is prompted whether application needs to be installed in default
Application directory as shown below.

Installing Applications El

Inskall "Maonitek Messenget” using the default application install direckary?

Mo Cancel |

Choose Yes to Install the Application in Default directory.

On Completion of downloading the Application to Pocket PC, Message is
displayed as Shown below. Press “OK”

Application Downloading Complete El

Please check your mobile device screen ko see if additional steps are necessary o complete this

installakion.
Ok |

Follow the instructions on the Pocket PC.
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6. Appendix

6.1 RS232 pin-out description

RS-232 Cable pin-out (DB-9 to Messenger connector)

Fora PC >
Messenger PC
16 DSR(-) 4 |DTR*
17  TX(Out) 2 |RX(In)
18 RX(In) 3 |TX (Out)
19 GND 5 |GND
For a PDA->
Messenger PDA
16 DSR () 4 |DTR*
17  TX(Out) 3 |RX(In)
18 RX(In) 2 |TX (Out)
19 GND 5 |GND

Please make sure your RS-232 cable pin-out is correct, or the connection will fail.

If DTR signal is NOT available or NOT active please use RTS pin 7.

REFERENCE PINOUT

The pin-outs below are referenced as coming from a PC serial data port via a

male DB-9 connector.

Pin Signal

1

2
3
4
5
6

DCD/RLSD
RXD
TXD
DTR
GND
DSR

Dir [Function

IN [ Carrier Detect

IN [Receive Data

OUT| Transmit Data

OUT|Data Term Ready
Ground

IN | Data Set Ready
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RTS

ouT

Request to Send

CTS

IN [ Clearto Send

RI

Ring Indicator
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6.2 Sensor Connections

6.2.1 Moniturb DUAL sensor forward scatter connections

The table below shows forward scatter sensor 1 and 2 connections to the
Monitek Messenger.

MONITURB F Sensor 1 and 2 (Forward Scatter) Flow cell(s)

Terminal | Wire color | Cable ID Signal

1 Brown FS (12°) sensor 1 (-) Direct beam

2 White FS (12°) sensor 1 (+) Direct Beam

3 Black FS (12°) sensor 1 (AC-GND) Shield
4 Yellow S (12°) sensor 1 (-) 12 Deg. Sensor
5 Green S (12°) sensor 1 (+) 12 Deg. Sensor
6 - - -

7 Brown S (12°) sensor 2 (-) Direct beam

8 White S (12°) sensor 2 (+) Direct Beam

9 Black FS (12°) sensor 2 (AC-GND) Shield
10 Yellow S (12°) sensor 2 (-) 12 Deg. Sensor
11 Green S (12°) sensor 2 (+) 12 Deg. Sensor

Messenger uses an EXTERNAL power supply to drive BOTH lamps.

The following connections are made to the EXTERNAL power supply assembly
control board. (Located inside the Messenger box without an LCD display).
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Lamp(s) connections

Sensor 1

Terminal

3 Lamp (Blue and Red)
4 Lamp (Grey and Pink)
Sensor 2

Terminal

5 Lamp (Blue and Red)
6 Lamp (Grey and Pink)

Control signals to the external power supply module are made using the following

connections:

Cable with three conductors: Orange/yellow/Black

From Monitek Wire color To External Lamp

Messenger Power supply control
board

29 Orange 9

30 Yellow 10

31 Black 11
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6.2.2 Moniturb forward scatter sensor connections

MONITURB —F Flow cell.

Terminal | Wire color Cable ID Signal

1 Brown FS module (-) Direct beam

2 White FS module (+) Direct Beam

3 Black FS module (AC-GND) Shield
4 Yellow FS module (-) 12 Deg. Sensor
5 Green FS module (+) 12 Deg. Sensor
6

7

8

9

Lamp connections (lamp connector located on the power supply board)

Terminal

1

Lamp (Blue and Red)

2

Lamp (Grey and Pink)
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6.2.3 Moniturb forward and side scatter MTFS sensor connections

Terminal # Wire color Cable ID Signal
1 Brown FS module (-) Direct beam
2 White FS module (+) Direct Beam
3 Black FS module (AC-GND) Shield
4 Yellow FS module (-) 12 Deg. Sensor
5 Green FS module (+) 12 Deg.
Sensor
Yellow SS module (-) 90 Deg. Sensor
Green SS module (+) 90 Deg.
Sensor
9 Black SS module (AC-GND) Shield

Lamp connections

Terminal

1

Lamp (Blue and Red)

2

Lamp (Grey and Pink)
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6.2.4 Model 450 COLOR sensor connections

Terminal # Wire color Cable ID Signal

1 Brown MS-450 module (-) REF. Beam
2 White MS-450 module (+) REF. Beam
3 Black MS-450 module (AC-GND) Shield
4 Yellow MS-450 module (-) Meas. Beam
5 Green MS-450 module (+) Meas. Beam
6 - - -

7 - - -

8 - - -

9 - - -

10 - - -

11 - - -

12 - - -

Lamp connections

The Model 450 sensor requires a separate power supply for the lamp. It should

NOT be powered from the Messenger module. Use the external control board

for Lamp control:

Connections are made to Pins 3 and 4 of the EXTERNAL LAMP CONTROL
board (LAMP(s) connector).
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6.2.5 MSAD COLOR Sensor Connections

Terminal# Wire color Cable ID Signal

1 Brown MS-AD module (-) REF. Beam

2 White MS-AD module (+) REF. Beam

3 Black MS-AD module (AC-GND) Shield
4 Yellow MS-AD module (-) Meas. Beam
5 Green MS-AD module (+) Meas. Beam
6 - - -

7

8

9

* MSA uses only terminals 1, 2, and 3.

Lamp connections

Terminal

1

Lamp (Blue and Red)

2

Lamp (Grey and Pink)
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6.2.6 Model FS4/FS5 sensor connections

Terminal# Wire color Cable ID Signal

1 Black Probe module (-) Sense Beam
2 Red Probe module (+) Sense Beam
3

4

5

6

7

8

9

10

11

12

Probe LIGHT source Connections

Terminal# Wire color Cable ID Signal
1 Green Probe Module (-) LED
2 White Probe module (+) LED
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6.2.7 Model 25 (CSK, CSS, CSH) sensor connections

Terminal# Wire color Cable ID Signal

1 Black Probe module (-) Sense Beam
2 Red Probe module (+) Sense Beam
3 Green Probe Module (AC-GND) Shield
4

5

6

7

8

9

10

11

12

Probe LIGHT source Connections

Terminal# Wire color Cable ID Signal
1 White Probe Module (-) LED
2 Orange Probe module (+) LED
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6.2.8 TS2 Sensor Connections

Terminal# Wire color Cable ID Signal

1 Black TS2 module (-) Direct Beam

2 Red TS2 module (+) Direct Beam

3 White TS2 module (AC-GND) Shield
4 Green TS2 module (-) 12 Deg Sensor
5 Yellow TS2 module (+) 12 Deg Sensor
6 - - -

7

8

9

Lamp connections (Must be connected to External Lamp card)

Terminal
3 Lamp (Orange)
4 Lamp (Green)
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6.3 Power supply Jumper configuration:

The power supply may be configured to power up either the Flow cell or the Bio

probes FS4 and FS5 series.

The settings are as follows:

Flow Cell lamps (1A typical current at approximately 5V)

1A

O OO
O OO

FS4 and FS5 BIO- PROBES (position 3-4) as shown below.

O OO

O
O
O

These jumpers are set at the Factory.

@ DO NOT MODIFY
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6.4 OPTIONAL LAMP control board

Using the OPTIONAL lamp(s) control board the user may power up to three
sensors. The sensors may be Flow cells using Lamps or Probes using LED'’s.

The Board has jumpers for selecting the type of sensor to power.

Jumpers J4, J5 and J6 are for selecting either a LAMP device (1A current)
Jumper INSTALLED or a probe device (340 mA) Jumper REMOVED.

@ CONNECTING A PROBE DEVICE TO A CHANNEL THAT IS
CONFIGURED FOR A LAMP DEVICE WILL DAMAGE THE PROBE.

EXTERNAL LAMP CONTROL CONNECTOR PIN OUT:

+5V at 4 A MAX (from Power supply)

GND (-) (from Power supply)

DEVICE #1 (LAMP/PROBE)

DEVICE #1 (LAMP/PROBE)

DEVICE #2 (LAMP/PROBE)

DEVICE #2 (LAMP/PROBE)

DEVICE #3 (LAMP/PROBE)

DEVICE #3 (LAMP/PROBE)

LAMP ON/OFF (H/L) Control FROM Messenger Pin 29 (Orange wire)

LAMP FAULT (L) signal TO Messenger Pin 30 (Yellow wire)

= =] O 0| Nl O Of & W N| =

- O

GND (-) connects to Messenger Pin 31 (Black wire)

JUMPERS J1 thru J3 (ACTIVE)
These jumpers control activation of the fault detection for each of the connected

devices:

-60-




Example if you have a device (Lamp or probe) connected to pins 3 and 4 then
you may enable fault detection for this device by placing a jumper in position 1
(JP1)i.e.:

Connect Jumper #1 to enable Fault signal from | Device #1
Connect Jumper #2 to enable Fault signal from | Device #2
Connect Jumper #3 to enable Fault signal from | Device #3

Device Fault is Signaled when Device is OPEN or when the current to the Device
drops below 200 mA (Fault Setup is done using “LAMP CONTROL” menu using
the graphical user interface software).

On board LED’s:
RED LED s ON when Fault is detected

Green LED is ON when power is ON (Control from Messenger)

6.5 Internationalization

Messenger Software Supports 4 Languages English, German, French and
Spanish.

I. Run the Messenger Application
II. Choose > Select Language to switch to different language

Note: - Selected language should match with Regional settings of the computer
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6.6 On-Line Help menus and related contents

This section describes the HELP menus and related contents.
Software HELP menus

6.6.1 Main Menu

This menu helps in navigating to various Messenger options.
Choose Main Menu

= Calibration Menu

=  Setup Results Menu
= Setup Inputs/Outputs
= Diagnostic Menu

= Set Cleaning Event

= Set Access Code

= Set Access Level

= Measurements screen

6.6.2 Set Calibration Menu

This menu is used to correlate raw data collected from the sensors (photo
detectors) corresponding to a specific standard or sample concentration. Up to 8
different calibration data points can be stored for each of the four sensors read
by the instrument. From this information the instrument can construct a lookup
table.

Choose Main Menu > Calibration Menu

Select the Sensor, which needs to be calibrated.

You have two calibration tables, Factory calibration and Process calibration
tables. Choose the desired calibration table, which needs to be changed by

selecting the respective button
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» Factory Calibration
= Process Calibration

Note: Factory calibration table can be altered / viewed using FACTORY level

Access permissions.

6.6.2.1 Process Calibration

= Build Calibration

= View/Edit Calibration
» Fit Data

= Copy Fact Table

Build Calibration

For each Sensor, up to 8 different samples can be used during the calibration

process.

Select the Sensor number by choosing the Sensor Toggle Button.

Select the Sample number by choosing the Sample Toggle Button.

Enter the User Value (Ex: - Known concentration value of a Standard) in the text
box provided. This value can also be changed using View/Edit Calibration

menu.

Choose Read New Data to capture the data.
Choose Store New Value to store the data.

Repeat steps 2 to 5 for each sample.
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View/Edit Calibration

The selected Sensor number appears on the top. The data present in the
selected process calibration table can be viewed/edited using the following

option.

To edit user value or data, Tap/Click on the cell.

Choose Graph to view the curve fit based on the Fit Type selected.

Choose Edit Sensor Equations to alter the Sensor Equations.

Fit Data

Choose the type of Curve Fit to be performed on the Calibration data. There are

4 options available.

= Linear Fit Process Data
= Curve Fit Process Data
» Linear Fit Factory Data
= Curve Fir Factory Data
Copy Factory Table
The selected sensor's factory calibration table is copied to process calibration
table.
6.6.2.2 Factory Calibration
= Build Calibration
= View/Edit Calibration

Build Calibration

For each Sensor, up to 8 different samples can be used during the calibration

process.
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Select the Sensor number by choosing the Sensor Toggle Button.
Select the Sample number by choosing on the Sample Toggle Button.

Enter the User Value (Ex: - Known concentration value of a Standard) in the text
box provided. This value can also be changed using View/Edit Calibration

menu.

Choose Read New Data to capture the data.
Choose Store New Value to store the data.
Repeat steps 2 to 5 for each sample.

View/Edit Calibration

The selected Sensor number appears on the top. The data present in the
selected factory calibration table can be viewed/edited using the following option.

To edit user value or data, Tap/Click on the block.

Choose Graph to view the curve fit based on the Fit Type selected.

Choose Edit Sensor Equations to alter the Sensor Equations.

6.6.3 Setup Results

The Setup Results are used for formatting the output that is to be displayed to

the user, which is captured from different sensors

Choose Main Menu > Setup Results Menu. You will see different Options to

format the output

= Setup Results Nametags
= Setup Results Equations
=  Setup Sensor Equations
=  Setup Numerical Results

= Setup Graphical Results
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= Set Results Units
= Setup Data logging
= Bubble Reject Threshold
=  Set Results Format
= Set Results Offset
6.6.3.1 Setup Results Nametag
Choose the Result (1...4) Text box to specify the Nametags to be displayed for

results captured in the Measurements Screen.

For Example: - If the data captured in Result1 is Turbidity then the Nametag for
Result1 can be given as "Turbidity"

6.6.3.2 Setup Results Equation

Choose the Result (1...4) text box to specify the Result Equations.

Rules for Result Equations:

1. An Equation can consist of 5 terms combined by operators.

2. Each term can be a sensor or logarithm of sensor and can have a
numerical factor.

3. The fifth term is +/- offset and can only be added.

For Example: -

The Equation is constructed by "term1 [op] term2 [op] term3 [op] term4 + offset"
where each term can be a sensor or the logarithm of sensor and has a numerical

factor (i.e. 3.67LogSEN4). The operators [op] can be +, -, *, /.

6.6.3.3 Setup Sensor Equation

Choose the Sensor (1...4) text box to specify the Sensor Equations.
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Rules for Sensor Equations:

1. An Equation can consist of 5 terms combined by operators
2. Each term can be a channel or logarithm of channel and can have
a numerical factor

3. The fifth term is +/- offset and can only be added

For Example: -

The Equation is constructed by "term1 [op] term2 [op] term3 [op] term4 + offset"
where each term can be a channel or the logarithm of channel and has a
numerical factor (i.e. 3.67LogCH1). The operators [op] can be +, -, *, /.

6.6.3.4 Setup Numerical Display

You can format the Numerical display. Check on relevant Show Result
checkboxes to select which results need to be displayed during the Numerical

display in Measurements screen.

Choose Font Size Toggle Button to specify the Font Size (Small / Medium/

Large) with which the results need to be displayed.

= When all results are selected for display Font size can be only small.
= When 3 results are selected for display Font size can be Small/Medium.
= When 2 or less results are selected for display Font size can be

Small/Medium/Large.

Choose Show All when all results need to be displayed.

6.6.3.5 Setup Graphical Display

You can format the Graphical display in Measurements screen. Check on Show
Result checkboxes to select which of the results need to be displayed during the

Graphical display.

Choose Range of Values to specify the Lower & Upper Limits of the Graph.
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Choose Time Step in Minutes to specify the time duration with which the X-Axis

Scale needs to be displayed.

Choose Show Color to select the color with which the result should be displayed

on the graph.

Note: Time Step in seconds can be specified by entering decimal values
Ex:-0.1,0.2.

6.6.3.6 Set Results Units

Choose the Result (1...4) Text box to specify the units to be displayed for results

captured in the Measurements Screen.

For Example: - If the data captured in Result1 is Turbidity then the unit of Result1
can be given as "FTU".

6.6.3.7 Setup Data Logging

You can specify the Time Interval (Sec) with which the data needs to be stored in
buffer for each result.

Choose Store Result1 (1...4) text box to specify the time in seconds.

Choose Set Buffer Size to Specify the Buffer Size for each Result

In order to default the values Choose Set Default Values (i.e. 60 Seconds).
Note: Changing Data Logging rate clears the PREVIOUS DATA of the selected
Result.

6.6.3.8 Setup Buffer Size

Choose Result Storage Size (1.... 4); specify the storage size of each result.

If the data to be stored exceeds the Result storage size, Existing data is
overwritten.
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Choose Default Values (i.e. 500)
Note:
Total maximum stored results can’t exceed 8000.

Changing the Buffer Size clears PREVIOUS DATA of ALL Results.

6.6.3.9 Bubble Reject Threshold

Bubble Reject Filter is used to smooth system response when bubbles are
passing and based on a data averaging and acts upon a threshold limit set by the
user in %change detection.

Choose Bubble Reject textboxes to specify the % Threshold.

Choose Filter Delay textboxes to specify the delay in sec.

6.6.3.10 Set Results Format

You can format the results displayed in Measurements screen.

Choose Number of Decimal Places for each Result to specify the precision with
which the result needs to be displayed in Measurements Screen.

Choose Allow Values for each Result to specify whether POS (Positive values)
or ALL (Positive and Negative values) to be displayed in Measurements Screen.

6.6.3.11 Set Results Offsets
Choose OFFSET TO RESULT (1...4) text box to specify the Offset.

The Offset Specified here will be a part of the Setup Results Equations.
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6.6.4 Setup Inputs/Outputs Menu

You can configure the Inputs / Outputs of the Messenger Device.

Choose Main Menu > Setup Inputs / Outputs Menu. You will see the following

Options.

= Set LCD Display

= Set Analog Outputs

= Assign Digital Inputs

= Set Alarms

= Set Messenger Unit ID
= Set Relay Functions

6.6.4.1 Set LCD Display

The LCD display Contains 4 Lines, which can be configured to display Results,
Sensors, and Temperature values. You can adjust the contrast of the LCD

display.

Choose Line (1...4). Enter the text, which needs to appear on the Line.
Select the Signal (Results / Sensors / Ambient) that needs to appear along

with the selected Precision.

In order to adjust the contrast of the LCD, Choose "+" / "-" to increment or

decrement the value. The default contrast value is 115.

The Maximum text that can be displayed on a Line is 20 characters. When a
Signal is assigned only 11 characters of text entered will be displayed and the

remaining characters get truncated.
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6.6.4.2 Set Analog Outputs

The system has FOUR independent and assignable Analog 0/4 -20 mA loops,
which can be connected to External Devices. Each output will operate from a
user-defined RESULT equation. The sub-menus allow you to set all the
necessary parameter values for Low and High limits and the required mode for

the analog output.

Over range:

Analog Outputs can flag abnormal conditions or upset conditions that can be
caused by Malfunction of Optics or by some material coating over the windows.
We can assign a range of mV for normal operation. If the range exceeds, a fault
is registered and an appropriate error message (OPTICS FAULT) will be

displayed on the LCD and Measurements Screen.
How to configure Analog Outputs?

» To configure the Analog Output, Choose the ANALOG OUT (Out 1-4).

» Choose Output Toggle Button (Not Assigned / Result1 / Result2 / Result3
/ Result4) to specify the user defined RESULT equation needs to be
assigned to ANALOG OUTPUT.

» Choose Mode Toggle Button to Specify the Mode (0/4-20 mA) Loops.

» Choose Low, High text boxes to specify the Low and High mV.

» Choose Overrange toggle button to specify the channel (CH1...4) Assign
the range of mV for normal operation by choosing the Low mV and High
mV.

Note:

In case any of the Analog Output is not used, make sure that OUTPUT,
OVERRANGE parameters are "NOT ASSIGNED".
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6.6.4.3 Assign Digital Inputs

Choose Cleaning Event 1...2

Set Cleaning Frequency in Hours = 0

Specify the Cycle Duration, and Purge Time. Save the settings. Activate the
Relay through Assign Digital Inputs. The Cleaning Cycle gets activated ONLY
ONCE.

Note: Whenever you are trying to activate a Cleaning Event through Assign
Digital Inputs make sure that the Cleaning Frequency in Hours is 0. Failing to do

so may cause malfunctioning of the Cleaning Event.

6.6.4.4 Set Alarms

You can setup Alarm set conditions. Each Alarm can have a HYSTERESIS and

a TIME DELAY (the condition must be met for at least this time before the alarm
is reported). The alarm mode (LOW, HIGH, LOW LATCH, HIGH LATCH) can be
selected per individual Alarm.

Alarms can be assigned to the following signals

= Result1
= Result?
= Result3
= Result4

=  Ambient Temp
= General Alarm
The different Alarm Types are
* Low
= Low Latch
»= High
= High Latch
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Choose on the Alarm (1- 4).

Specify the signal to which the Alarm needs to be assigned to, by Choosing on
the Assigned Signal Toggle Button.

Choose Type Toggle Button to specify the type of Alarm.

Choose Limit text box to specify the mV. Choose Delay on Make/Break Text box
to specify the delay in which the condition needs to be met at least before the

alarm is reported.

Choose on Hysteresis to Specify the Hysteresis value

The Hysteresis value will not have any effect for High and Low Latches.
In case any of the Alarms are not used, make sure that Type and Assigned
Signal are "NOT ASSIGNED".

6.6.4.5 Set Messenger Unit ID

The UNIT ID is necessary when multi-units are connected on the same bus.

Choose Unit ID to specify the ID of the Messenger. The Unit ID should lie
between 1...255.

Choose Messenger Tag to specify the extra information for easy identification

when multiple devices are connected in the network.
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6.6.4.6 Set Relay Functions
This menu allows the user to assign the FUNCTION of the Relay.
Functions available are:

= NOT ASSIGNED
= Alarm 1

= Alarm 2

= Alarm 3

= Alarm 4

= General Fault

= Cleaning device 1

= Cleaning device 2
Relay functions in 2 states
= Active ON
= Active OFF Fail -Safe
ACTIVE ON:
As long as assigned function is TRUE The Relay stays in activated state.
For Example:

The Alarm 1...4 are selected and thresholds are defined in the Set Alarm menu. If
we set an Alarm on Result 1 exceeding a threshold of 100 and we assign Relay
#1 as an indicator of such Alarm condition, the Relay#1 is activated when this
threshold is reached or exceeded based on the Alarm mode latching or NON-

latching. It would reset when the Result is back below the threshold defined.
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Active OFF Fail Safe:
As long as the Assigned signal is FALSE the Relay stays in activated state
For Example:

The Alarm(s) 1...4 are selected and thresholds are defined in the Set Alarm
menu.

If we set an Alarm on Result 1 exceeding a threshold of 100 and we assign Relay
#1 as an indicator of such Alarm condition, the Relay#1 is NOT activate as long
as the Alarm condition is TRUE.

6.6.5 Diagnostic Menu
This menu is provided with diagnostic tools.

Choose Main menu > Diagnostic Menu, you will see a list of Diagnostic options.

= File menu

= View Channel Output

= Adjust Hardware settings
= Hardware Test

= Software Revision

= Clear Reset Menu

6.6.5.1 File Menu

The parameters set by the user can be saved and these can be retrieved at a

later point of time.

Choose Save Parameters to File. You will see a dialog pop up Specify the
name of the file in which the parameters need to be saved. These files will be

stored with .pda extension and are referred as PDA Files.

Choose Load Parameters from File. You will see a dialog pop up. Select the file

in which the parameters have been stored earlier. During the process of reading
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the data from the File and Transferring to Messenger Device, the percentage of
data that has been transferred will be displayed on the button.

Choose Load Firmware to prepare the Messenger Device ready for Installation

of Firmware.

6.6.5.2 View Channel Outputs

Here you can view the outputs from all the 4 channels and Messenger Ambient

Temp.

Raw Data:
Raw Data is channel mV displayed irrelevant of ZERO DARK CURRENT.

Channel Signal:
Channel signal is Channel mV displayed after we subtract the ZERO DARK
CURRENT.

Choose Show Raw Data / Show Channel Signal Toggle Button to switch

between the display of Raw data and Channel signal.

6.6.5.3 Adjust Hardware Settings

Using this menu. You can adjust the hardware settings

= Zero Dark Current

=  Optimize Channel Auto

=  Optimize Channel Manual
= Set Dark Current Auto Zero
= Set Channel Reference

= (Calibrate Analog Outputs

=  Set ADC-GAIN Manual
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Zero Dark Current
You can store the Zero Dark Current using this menu.
Choose "ZERO CHANNELS" to store the dark current. The lamps are turned

OFF and the system will take a reading for ALL the channels and stores it as

Dark current.

Choose "Restore Defaults Settings" to set the Zero Dark Current to 0.

Optimize Channel Signal Auto

The Messenger Device is provided with Multi Stage Amplification. The Primary
stage of Amplification is done with help of Front End Amplifiers
and Secondary stage of Amplification is done with in the Analog to digital

converter (ADC) that has an Internal amplifier.

The Front End Amplifiers setting can be done using Optimize Channel Auto.

%Range is related to the set point i.e. 100% which is 2000mv and 120% is 2500
mV which is the range of the ADC Converter.

Raw mV displays the current channel mV

Choose Channel (CH1...4)

When a Channel is selected and the Optimize Gain key is entered, the
Messenger will try to set the Gain (Increase or decrease) to adjust the output
level of the amplifier to 2000 mV (with range set at 100%) or higher if the 100% is
higher, this relates to the A/D input of 2500 mV (80 to 120%).

Choose Restore Default Settings to restore the %Range to the default value i.e.
100.
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The TRIMPOTS of the Front End Amplifier can be selected manually using
Optimize Channel Manual.
Optimize Channel Signal Manual

This shows the TRIMPOT settings on the front end Amplifier Range 0 to 100.
Choose Channel (1...4) and Tap/Click on "+" or "-" In order to increment or
decrement the TRIMPOT Settings.

Auto Zero Dark Current

Choose Auto Zero Frequency in Hours text box to specify the Time Interval
(Hours) at which the Dark current should be made zero.

Store Channel Reference

Using this option you can store a reading from a channel, which allows us to
store an initial reference reading for the channel.

For Example:

When doing a color measurement with a single channel (detector) the equation

for sensor may look like the following

LOG REF CH1 — LOG CH1. Where LOG REF CH1 is a constant as it relates to
the initial energy level with clear water in the cell.

Store Reference:

Choose CH (1...4).
When a channel is selected and STORE REFERNCE key is entered the current

reading of the channel will be stored as Reference

When a channel is selected and RESET REFERENCE key is entered the

Reference value will be defaulted to zero.

Normalization:
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Choose CH (1...4).
Choose the channel (CH1 / CH2 / CH3 / CH4) with which the selected channel

needs to be normalized and Normalized Key is entered. The Channel gets
normalized.
Note:

Normalized Channel values are displayed in Green color.

Calibrate Analog Outputs

You can Calibrate Analog Outputs or adjust the 0/4- 20 mA loop, this is like a trim
pot adjustment.

For example, the 4 mA to 4.00 mA (Zero setting) and 20 mA to 20.00 (Factor
setting) as the technician sets these loops he can iterate between the zero and

factor to adjust the 4-20 mA exactly to the right levels.

Choose CH (1...4)
Choose Zero Setting and Tap/Click on "+" or "-" in order to increment or
decrement by 0.025.

Choose Factor Setting and Tap/Click on "+" or "-" In order to increment or
decrement by 0.0005 value.

ADC-GAIN Manual

This is a secondary stage of Amplification setting on the ADC chip where we
have a FRONT end Amplification setting using the electronic trim pots which can

be adjusted using Optimize Channel Auto or Optimize Channel Manual.
ADC gain setting allows a second stage of amplification when we are looking at

very low signals and we need to amplify further beyond the front-end range
adjustment allowed.
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This of course will cause a higher offset voltage and may reduce the range of the
detection because of this offset potential that is due to the multi-stage

amplification and the initial offset potential of the front-end op-amps.

The settings are defaulted to 1 but may be adjusted to 2,4,8,32,64,128
Choose Channel (1...4) and Tap/Click on the "+" or "-" in order to increment or
decrement the gain setting.

6.6.5.4 Hardware Test

This menu is used for testing of hardware

= Lamp Control
= Test Analog Outputs
= Test Relays
Lamp Control
You can view the current lamp's status and Lamp Intensity.
MAIN FAIL in Lamp Status indicates Lamp Failure.
Choose Lamp Intensity text box to specify the percentage of Intensity.
Choose Display Fault Toggle (INT LAMP / EXT LAMP / BOTH LAMPS) button to

explicitly generate Faults.

Choose Turn Lamp ON / Turn Lamp OFF Toggle Button to specify Whether
Lamp needs to be Switched ON / OFF.

Choose External Lamp ON / External Lamp OFF Toggle button to
specify whether External Lamp needs to be ON/OFF.

Test Analog Outputs
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This Menu displays the mV of the FOUR Analog Outputs. A Fault in the Analog
Output is displayed as "FAULT: 2mA" where 2mA is the current assigned during
the fault condition. You can also test the Analog outputs using this option.

For Example: -

Set Analog Out1 to the following parameters
OUTPUT = Result1

Low = Omv, High = 100mv

Mode = 4-20mA

OVERRANGE = CH1

Low mV = 0, High mV = 150

Choose Analog OUT1

Enter the 50 Millivolts in the Analog Output text box and choose the "Update
Outputs” key. The current observed at the Analog OUT1 should be 12mA.

Choose Restore Previous to restore the Analog Outputs to previous values

before the entry of 50 Millivolts.

Test Relays

This Menu displays the current status of the FOUR Relays i.e. Signal to which
Relay has been assigned and whether it is switched ON / OFF.
Choose the ON / OFF Toggle button to Switch ON / OFF the Relay.

6.6.5.5 Clear/Reset Menu

=  System Reset

= Default Values

= Clear Process Calibration
= Clear Factory Calibration
= Clear Results

=  Reset Alarms
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Choose System Reset to reset the Hardware.

Choose Default Values to default the parameters of the Messenger.

On Selection of Default Values, Factory calibration table will not be defaulted.
Clear Process Calibration

Choose Sensor (1...4).

On Selection of Sensor, choose Copy From Factory Table key. Factory
calibration table contents of the Selected Sensor are copied to the Process

calibration table.

On Selection of Sensor, choose Clear Table key. Process calibration table
contents of Selected Sensor are defaulted to 0.
Clear Factory Calibration

Choose Sensor (1...4)

On Selection of Sensor when Clear Table key is entered. Factory calibration
table contents of selected sensor are defaulted to O.

Clear Results

Choose Clear Results (1-4) to Clear the Historic data stored in the buffer.

6.6.5.6 Reset Alarms

This menu displays the status of the 4 Alarms.

ACTIVE in the status block with RED background indicates Alarm is ON
In order to clear the Alarm, choose the Alarm with ACTIVE in the Status block

and choose Clear ALARM key.
6.6.5.7 Software Revision

The Menu displays the current Version Number of GUI and Messenger.

The Messenger Version will be displayed only when GUI is connected Online.
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6.6.6 Set Cleaning Event

You can program up to TWO cleaning events.

A cleaning event is an automatic cycle that allows the optics to be CLEANED by
the introduction of a cleaning solution to flow through the cell.

For each Cleaning Event, you can specify the Cleaning Frequency, Cycle
Duration and Purge Time (Time to allow the Sample to flow and purge out the
cleaning solution). A Relay can be assigned to a Cleaning Event, which will be
active only during the Cycle Duration.

Cleaning Events can be activated in 2 ways, automatically or through Assigned

Digital Inputs.

Automatic Mode:

Choose Cleaning Event 1...2
Specify the Cleaning Frequency, Cycle Duration, and Purge Time. The
Cleaning Event gets activated.

Once you save the settings.

Assign Digital Inputs:

Choose Cleaning Event 1...2

Set Cleaning Frequency in Hours = 0

Specify the Cycle Duration, and Purge Time. Save the settings. Activate the
Relay through Assign Digital Inputs. The Cleaning Cycle gets activated ONLY
ONCE.

Whenever you are trying to activate a Cleaning Event through Assign Digital
inputs make sure that the Cleaning Frequency in Hours is 0. Failing to do so may

cause malfunctioning of the Cleaning Event.
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6.6.7 Set Access Code

You can set Personal Access code for Operator, Technician and Factory
Levels preventing unauthorized personnel from altering key parameters that
affect the operation of the unit.

Choose Operator text box. An Interface pops up Specify the Operator Password.

Choose Technician text box. An Interface pops up Specify the Technician
Password.

Choose Factory text box. An Interface pops up Specify the Factory Password.
6.6.8 Set Access Level

You can enter the Access code based on the access code entered access level
changes.

Choose New Access Code text box. An Interface pops up Specify the new
Access code.

Note: On entering incorrect access code the Access Level will be defaulted to
Operator.

6.6.9 Measurements Screen
=  Previous Data
=  Online Analysis
= Alarm Status

6.6.9.1 Previous Data

Choose OPTIONS button =l on the top right corner of the measurements screen,

a popup menu appears.

Choose Previous Data.

Entire Previous Data is retrieved. Most recently logged data is displayed as first
frame of graph.
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Choose Previous "<" and Forward " >" buttons on the bottom of the graph
to scroll through the Previous Data.

Note: This operation may take some time to read the data from device and

process the data.

Choose Numerical / Graph / Bar Toggle button to switch between display
formats.
How can you view value of data point on a graph area?

Tap on the data point you want to view on the graph area, Crosshair appears

displaying the X-axis and Y-axis data.

Choose Previous "<" and Forward ">" buttons to scroll through the data in
the currently displayed frame.

Tap outside the graph area to remove the crosshair.

How can you customize the Numerical and Graphical display?

Graph settings can be configured using the following screen

e Setup Numerical Display
e Setup Graphical Display
e Graph Settings

6.6.9.2 Online Analysis
You can view data being captured by Messenger Device ONLINE.

The data captured from the Messenger Device can be viewed in 3 different

formats.

-85-



= Numerical Display
= Graphical Display
= Bar Chart Display

Numerical Display and Graphical Display can be customized using the Setup

Graphical Display, Setup Numerical display Menus.

Choose Numerical / Graph / Bar Toggle button to switch between the displays.

6.6.9.3 Alarm status

Status of Alarms is represented on the bottom of the Measurements screen.
Codes displayed in Alarm Status are shown below.

1 - Alarm 1 Active
2 - Alarm 2 Active
3 - Alarm 3 Active
4 - Alarm 4 Active
CC1 - Cleaning Event1 Active
CC2 - Cleaning Event2 Active
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6.7 Graph/Chart Recorder

1. Run the Messenger Application.
2. Navigate to Main Menu >Measurements Screen and Choose GRAPH
view.
CEE x|
Help

SAMPLE AMALYSIS

ol g m3 mt
130,00

100,00

F0.00

40,00

10.00 000000 000000

28, 062002

17:19:23

Msgr Idg

3. Choose the Button on TOP Right corner of Graph. Which displays a

Popup Menu with a list of options.
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View Previous Data

On Selection of Previous Data Menu. Results Selected in SETUP GRAPH
DISPLAY will be pulled from the Messenger and Displayed.

Once the data is retrieved from the Messenger, the data is plotted on the Graph.

ml =l
711.16

£33.37

35552

177.79 l—||||'
f B'Q':'Dge?:nu 10:10:00 10:4?ﬁu‘
| 25-AlG-0Z \:)

Choose the FORWARD and BACK buttons to navigate through the DATA SETS.
Each data set displayed contains 100 points or as many available in that group.

Data Sets are grouped based on DATE.

POINT UNDER CURSOR

Choose the point you want to view by Tap/Click on the graph area. A Cross Wire

with corresponding X, y values is displayed as shown below.
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Choose the FORWARD and BACK buttons to navigate through the Points
displayed on the Graph.
Note: To remove the Crosswire Tap/Click outside the Graph Plotting area

When Cross wire is present the BACK and FORWARD buttons move the cross
wire through DATA POINTS in the absence of cross wire the BACK and
FORWARD buttons help in moving through the DATA SETS

View ONLINE DATA

Choose this option to get Online Data from Messenger.

Setup Graph Display

Choose Setup Graph Display a Dialog appears as shown below.

SETUP GRAPHICAL DISPLAY OF
RESULTS

Range of ¥alues
O ..

Time steps in Minuktes

1 2
Show Result:

Select Color :

Show ALL

Range Of Values
Specify the Lower Limit & Upper Limit of the Graph.
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Select Color
Click on Select Color of Result (1,2,3,4). A dialog pops up displaying the

list of colors. Select the color.

Show Result
Check the results that should be displayed on Graph.

After changing the above options Press on the BACK button the graph is

displayed with new selections taking into affect.

Graph Settings

Choose Graph Settings a Dialog appears as shown below.

GRAPH SETTINGS .

Background Color:
Horizontal Tic Lines:
¥ertical Tic Lines:
Line Thickness:

¥ -Axis Precision:

[ Line Style Solid
[ show Grid Lines

BACK

Background Color
Click on the background color. A dialog pops up displaying the List of

colors. Choose the Color.
Horizontal Tic Lines

Specify the number of Horizontal tics to be displayed on the Graph.

Note: For tics greater than 10 the labels may overlap
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Vertical Tic Lines
Specify the number of Vertical tics to be displayed on the Graph

If tic lines is <=2 the display is HH:MM:SS

If tic lines is >2 and < 6 the display is MM:SS

If tic lines is >6 the display is SS

Where HH Represent Hours, MM represent Minutes, SS Represent
Seconds.

Note: for tics greater than 9 the labels may overlap

Line Thickness
Specify the Line thickness.

Note: Display may not be proper if line thickness is greater than 3

Y-axis Precision
Specify the precision with which the y-axis data needs to be displayed.

Line Style Solid
Select this option if line style needs to be solid. If it is not selected, the

line style will be dashed.

Show Gridlines
Select this option to Show/Hide Gridlines.

Copy Image
This feature is used to capture the graph as Image and transfer it to the

Clipboard.

The transferred Clipboard Image can be pasted in Word Document or in
any other applications that support Image clipboard.
To use this Choose Copy Image

Copy Data

This feature is used to capture the data present in the Graph and transfer

it to the clipboard.
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The Transferred clipboard data can be pasted in Word / Excel or any other
applications that support clipboard.
To use this feature Choose Copy Data.
SaveAs Bitmap
This feature is used to capture the Graph Image and save as a Device

Independent Bitmap.

To use this feature Choose SaveAs Bitmap. Specify the Name of the File

and Location.
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6.8 Manufacturer’s Warranty Statement

Galvanic Applied Sciences Inc. (“Seller”) warrants that its products will be free from
defects in materials and workmanship under normal use and service in general
process conditions for 12 months from the date of Product start-up or 18 months
from the date of shipping from Seller’s production facility, whichever comes first
(the “Warranty Period”). Products purchased by Seller from a third party for resale
to Buyer ("Resale Products") shall carry only the warranty extended by the original
manufacturer. Buyer agrees that Seller has no liability for Resale Products beyond
making a reasonable commercial effort to arrange for procurement and shipping of
the Resale Products. Buyer must give Seller notice of any warranty claim prior to
the end of the Warranty Period. Seller shall not be responsible for any defects
(including latent defects) which are reported to Seller after the end of the Warranty
Period.

THIS WARRANTY AND ITS REMEDIES ARE IN LIEU OF ALL OTHER
WARRANTIES OR CONDITIONS EXPRESSED OR IMPLIED, ORAL OR
WRITTEN, EITHER IN FACT OR BY OPERATION OF LAW, STATUTORY OR
OTHERWISE, INCLUDING BUT NOT LIMITED TO, WARRANTIES OR
CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE, WHICH SELLER SPECIFICALLY DISCLAIMS.

Seller’s obligation under this warranty shall not arise until Buyer notifies Seller of
the defect. Seller's sole responsibility and Buyer's sole and exclusive remedy
under this warranty is, at Seller’'s option, to replace or repair any defective
component part of the product upon receipt of the Product at Seller’s production
facility, transportation charges prepaid or accept the return of the defective Product
and refund the purchase price paid by Buyer for that Product. If requested by
Buyer, Seller will use its best efforts to perform warranty services at Buyer’s facility,
as soon as reasonably practicable after notification by the Buyer of a possible
defect provided that Buyer agrees to pay for travel time, mileage from the Seller’s
facility or travel costs to the airport / train station closest to Buyer’s facility plus all
other travel fees, hotel expenses and subsistence.

Except in the case of an authorized distributor or seller, authorized in writing by
Seller to extend this warranty to the distributor’'s customers, the warranty herein
applies only to the original purchaser from Seller (“Buyer”’) and may not be
assigned, sold, or otherwise transferred to a third party. No warranty is made with
respect to used, reconstructed, refurbished, or previously owned Products, which
will be so marked on the sales order and will be sold “As Is”.

Limitations
These warranties do not cover:
+ Consumable items such as lamps.

* Analyzer components which may be damaged by exposure to contamination
or fouling from the process fluid due to a process upset, improper sample
extraction techniques or improper sample preparation, fluid pressures in
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excess of the analyzer's maximum rated pressure or fluid temperatures in
excess of the analyzer’'s maximum rated temperature. These include but are
not limited to sample filters, pressure regulators, transfer tubing, sample
cells, optical components, pumps, measuring electrodes, switching
solenoids, pressure sensors or any other sample wetted components.

« Loss, damage, or defects resulting from transportation to Buyer’s facility,
improper or inadequate maintenance by Buyer, software or interfaces
supplied by Buyer, operation outside the environmental specifications for the
instrument, use by unauthorized or untrained personnel or improper site
maintenance or preparation.

* Products that have been altered or repaired by individuals other than Seller
personnel or its duly authorized representatives, unless the alteration or
repair has been performed by an authorized factory trained service
technician in accordance with written procedures supplied by Seller.

* Products that have been subject to misuse, neglect, accident, or improper
installation.

« The sole and exclusive warranty applicable to software and firmware
products provided by Seller for use with a processor internal or external to
the Product will be as follows: Seller warrants that such software and
firmware will conform to Seller’s program manuals or other publicly available
documentation made available by Seller current at the time of shipment to
Buyer when properly installed on that processor, provided however that
Seller does not warrant the operation of the processor or software or
firmware will be uninterrupted or error-free.

The warranty herein applies only to Products within the agreed country of original
end destination. Products transferred outside the country of original end
destination, either by the Seller at the direction of the Buyer or by Buyer’s actions
subsequent to delivery, may be subject to additional charges prior to warranty
repair or replacement of such Products based on the actual location of such
Products and Seller’s warranty and/or service surcharges for such location(s).

Repaired Products
Repaired products are warranted for 90 days with the above exceptions.

Limitation of Remedy and Liability
IN NO EVENT SHALL SELLER BE LIABLE TO BUYER FOR ANY INDIRECT,
CONSEQUENTIAL, INCIDENTAL, SPECIAL OR PUNITIVE DAMAGES, OR FOR
ANY LOSS OF USE OR PRODUCTION, OR ANY LOSS OF DATA, PROFITS OR
REVENUES, OR ANY CLAIMS RAISED BY CUSTOMERS OF BUYER OR ANY
ENVIRONMENTAL DAMAGE OR ANY FINES IMPOSED ON BUYER BY ANY
GOVERNMENTAL OR REGULATORY AUTHORITIES, WHETHER SUCH
DAMAGES ARE DIRECT OR INDIRECT, AND REGARDLESS OF THE FORM OF
ACTION (WHETHER FOR BREACH OF CONTRACT OR WARRANTY OR IN
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TORT OR STRICT LIABILITY) AND WHETHER ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES OR NOT.
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